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ABSTRACT 

 

Effects of hemodynamic forces on cellular response are well studied. Wall shear stress is 

regularly accepted as the primary hemodynamic force affecting cellular response. Hemodynamic 

forces studies utilize Petri dishes on orbital shakers to grow cells for the experiments since this is an 

easily scalable system. However, characterizing the hemodynamics is difficult since the oscillatory 

swirling motion creates multidirectional and variable magnitude shear throughout the dish. Thus, a 

novel geometry dish that could create uniaxial shear with less variation in magnitude would be 

advantageous for studying shear stress effects on cellular response. 

The purpose of this thesis was to explore the ability for creating narrow shear ranges in terms of 

magnitude and direction, and to determine DOSI in novel geometry dishes. The new geometries 

consist of a narrow channel flat bottom dish and a narrow channel banked bottom dish. The study 

used computational fluid dynamics (Fluent) to simulate the fluid motion in the dishes. The study 

concluded with successfully identifying conditions surrounding regions of low variation of 

magnitude and direction of shear and DOSI patterns. For the NCF dish the least variation in shear 

magnitude, between radial locations, occurs at 60 RPM. In terms of the DOSI values, the NCF dish 

had increasingly higher DOSI values, meaning more uniaxial favored (tangential) flow across the 

surface of the dish as speed increased. The lowest variation occurred at 180 RPM. For the NCB dish 

the least variation in shear magnitude, between radial locations, occurred at 90 RPM. The NCB 

dish’s narrow range of shear stress is hypothesized to be the result of a more parallel fluid surface 

relative to the bottom surface of the dish. The NCB dish had DOSI values close to 1.0, meaning more 

uniaxial favored (tangential) flow, at the 80% and 90% radial locations for speeds between 120 and 

180 rpm. 
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NOMENCLATURE 

a 

 

= cylinder radius or narrow channel gap width  

As = surface area  

dc = characteristic dimension  

f = frequency of rotation  

Fr = Froude number  

Fs = shear force  

g = gravitational acceleration  

H = mean fluid height 

 

 

h = enthalpy  

M = mass  

R = orbital radius  

Re = Reynolds number  

Si = entropy  

Sl = slope ratio  

Sm = source term for the addition of mass  

St = Stokes number  

u = velocity   

y = height  

ρ = fluid density  

τ = shear stress  

τω = wall shear stress  

                          θ = angle of banked dish bottom relative to orbital  

  platform  

μ = fluid viscosity  

ν = kinematic viscosity  

ω = angular velocity  
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I. INTRODUCTION 

 

Scientists have studied the effects of hemodynamic forces on cellular response for more than 

40 years. Many scientists have used Petri dishes on orbital shakers to study cellular responses to fluid 

forces; however, scientists are still discovering methods to adequately manipulate these fluid forces. 

The lack of control limits the practicality of using orbital shakers for studying cellular responses. 

Scholars desire to understand the relationship of wall shear stress (WSS) and cell responses because 

wall shear stress is regularly accepted as the primary hemodynamic force affecting cellular 

responses. A new design to the Petri dish that provides control over wall shear stress, in particular, 

would add validity to simulation attempts thus further benefiting research of hemodynamic forces.  

Scientists studying hemodynamic forces utilize Petri dishes on orbital shakers for various 

reasons. The orbital shakers create an oscillatory flow which provides shear and nutrients to the cells. 

The oscillating motion of the fluid in a Petri dish is somewhat similar to the pulsatile flow of blood 

through blood vessels. Lastly, the orbital shakers are preferred because of the ease of use and 

scalability, where tens or hundreds of experiments can be run simultaneously. When viewed as a 

whole, the Petri dish and orbital shaker combination has strong advantages to other devices where 

experiments can generally only be run one at a time.  

Studies have shown that endothelial cells, such as those lining the interior walls of arteries 

and veins, become elongated and aligned with the direction of blood flow, as well as undergo 

biochemical changes (Levesque & Nerem, 1985). Because of fundamental differences between the 

actual pulsing flow of blood and the fluid motion in Petri dishes, cellular responses vary in the dish 

from what is experienced in vivo. Shear stress in these dishes has proven to vary greatly across the 

surface, making it difficult to correlate to cellular responses.  
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A new variable called the directional oscillatory shear index (DOSI), developed by 

Chakraborty (2011), and was defined to help characterize changing direction of flow in Petri dishes.  

The variable is defined as approaching zero for bidirectional oscillatory shear of equal magnitudes 

and approaches one for uniaxial oscillatory shear. Conventional dishes exhibited a DOSI approaching 

zero at the center and a DOSI approaching one at the wall, where large tangential WSS dominated a 

much smaller radial component. Statistical analysis has shown that DOSI had strong effects on 

factors such as cell proliferation, morphology, and gene expression. The dependence of these 

multiple factors on DOSI makes it a good indicator of fluid behavior and an important evaluative 

tool.  

Computational fluid dynamics (CFD) has accurately simulated the flow in orbiting dishes and 

with more ease than experiments. The key advantage of simulating fluid flow is the ability to 

determine fluid properties throughout the bottom surface of the Petri dish where cells reside.  

The purpose of this thesis was to explore the ability for creating narrow shear ranges in terms 

of magnitude and direction, and to determine DOSI in novel geometry dishes. The new geometries 

consist of a narrow channel flat bottom dish and a narrow channel banked bottom dish. The 

computational work was performed using Fluent, a commercial CFD software package. 
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II. REVIEW OF RELATED LITERATURE  

A. Definition of Shear Stress 

Shear stress is a useful fluid property that can be defined as a component of stress acting 

parallel to a surface, and is proportional to the shear rate. Viscosity is the proportionality variable and 

was explained by Bird et al. (2002) using a system of two parallel plates, with one moving and one 

stationary. At steady state, a force F must be applied to the moving plate to maintain a constant 

velocity. The force is proportional to the plate’s area and velocity, and indirectly proportional to the 

distance between the two plates. A velocity field is produced within the fluid between the two plates. 

The velocity gradient is the reciprocal of the slope of the velocity field. 

     
𝐹𝑠

𝐴𝑠
= 𝜇 

𝑢

𝑦
                             (1) 

Newton as well created a mathematical representation of viscosity and provides additional 

insight because of it varied form from Bird’s equation. The resulting Newton’s law of viscosity 

shows shearing force (per unit of area) is inversely proportional to the negative of the velocity 

gradient:   

   𝜏𝑥𝑦 = −𝜇 ∗
𝑑𝑢𝑥

𝑑𝑦
                            (2) 

In Newton’s equation, 𝜏𝑥𝑦 represents the shear stress, which is the force in the x direction on 

a unit of area perpendicular in the y direction.  The shear stress force exists in all flowing fluids and 

is essentially how momentum or motion is transferred through a fluid.  Newton’s law has been 

effective at defining the motion for a one-dimensional, laminar flowing, incompressible Newtonian 

fluid.  
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B. Experimental Determination of Shear Stress 

There are three main methods to generate shear stress in experiments on endothelial cells: 

parallel plate flow chambers, cone and plate apparatus, and orbital shakers.  The parallel plate flow 

chamber consists of two very long plates and a fluid-filled rectangular gap between the plates, the 

width of which is much smaller than the length of the two plates. While it is important to compensate 

for entrance effects when calculating shear stress, the parallel plate chambers produce uniaxial shear 

with laminar flow between the two plates. When Levesque and Nerem (1985) studied the response of 

tissue cells exposed to shear stress, they conducted the experiment using the parallel plate method. 

Levesque and Nerem (1985) developed equation (3) to calculate the shear stress on the endothelial 

cells.  

   𝜏𝜔 = 
6∗𝜇2

𝜌∗𝐻2 ∗ 𝑅𝑒                          (3) 

The cone and plate method also provides a uniform shear field over the entire lower surface 

on which the apparatus’ fluid resides.  The cone and plate apparatus consists of two circular plates 

that revolve around a central axis.  Even though radial speed increases as the distance from the 

central axis increases, the conical shape of one of the plates creates uniform shear. Ley et al. (1989) 

used the cone and plate method to understand polymorphonuclear neutrophil granulocyte (PMN) 

shear-dependent adhesion to endothelial cells. Since shear stress in this system depends on factors 

such as the rotational speed of the apparatus, basic geometry dimensions, and fluid properties, the 

derived equation for the behavior of shear stress in the system becomes: 

𝜏(𝑎) =  
2∗𝜋∗𝑎∗𝑓∗𝜇

𝐻
     (4)  
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In orbital shakers, the shear stress is generated by the fluid’s wave motion produced by the 

shaker.  Ley et al. (1989) used both an orbiting shaker and cone and plate method to study the shear 

dependent adhesion of human PMN to endothelial cells. They estimated the shear in the orbital 

shaker using Stokes’ second problem solution. Unlike Stokes’ first problem that is based on the shear 

stress of a thick fluid layer fluid moving at a suddenly accelerated to a constant velocity on a very 

large plate, the second solution is based on the shear stress with a wall moving in an oscillatory 

motion. The equation was given as: 

𝜏𝜔 =  𝑎 ∗ √𝜌 ∗ 𝜇 ∗ (2 ∗ 𝜋 ∗ 𝑓)3    (5) 

The above equation only predicts a scalar value to exist across the dish bottom, and does not 

seem to adequately compensate for the actual fluid dynamics created by waves with changing fluid 

heights. Another equation was developed for orbital shakers using the quasi-steady state assumption.  

This equation is based on viscous favored flow. While the equation is has greater accuracy with 

lower dimensionless variables (explained in section G), Equation 6 still provides acceptably low 

error at higher dimensionless values. The calculated shear stress is theoretically applied evenly 

throughout the dish bottom surface.  

       𝜏𝜔 =  𝑅 ∗ ℎ ∗ 𝜌 ∗ 𝜔2        (6) 

C. Examples of Shear Studies using Orbital Shakers 

There are several examples where orbiting dishes have been used to characterize cellular 

responses to shear.  Research by Ley et al. (1989) investigating PMN led to the results that a shear 

stress of 1.5 dynes/cm2 reduces PMN from 36 % to 21% and 59% to 35% on bovine serum albumin 

cells.  The research also used dextran sulphate to inhibit PMN; however, the dextran sulphate showed 

no effects as an inhibitor until shear stress was present.   
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Another research group, Yun et al. (2002) studied the effects of shear stress using shakers on 

the transcription factor Sp1 phosphorylation on metalloproteinase (MT1-MMP). (Sp1 is a 

transcription factor activated or inhibited by physiologic and pathologic stimuli. MT1-MMP is an 

enzyme known to play a major role in cell behaviors, such as cell proliferation, migration, and 

differentiation, among others.)  An orbital shaker was used to create shear stress that then activated 

or repressed the transcription factor on MT1-MMP. Yun found MT1-MMP responded differently to 

distinct environmental stimuli, such as cyclic strain versus shear stress. 

Kraiss et al. (2003) studied the mechanisms that by shear stress regulate E-selection protein 

production and activation of p70/p85 S6 kinase in endothelial cells.  In the study, they documented 

that the oscillating motion produced by orbital shakers had a similar reduction in E-selection protein 

expression as laminar flow produced in a cone and plate apparatus.  

Haga et al. (2003) attempted to determine the effects of hemodynamic forces on smooth 

muscle cells utilizing an orbital shaker. Despite previous findings that shear stress inhibited cell 

proliferation; they found that the oscillatory shear stress unexpectedly increased proliferation of 

smooth muscle cells.  The contradictory results were hypothesized to be an effect of oscillatory 

verses steady state flow, but that oscillatory shear remains more physiologically relevant to the 

pulsatile blood flow. They suggested that additional research aimed at defining variation between 

oscillatory and steady state shear would be preferential. A proper defined relationship would provide 

several advantages for example the ability to relate different research findings despite the type of 

shear stress used.  

While attempting to understand orbital shaker flow pattern, Dardik et al. (2005) experimented 

with the effects of orbital and laminar shear stress on endothelial cells and compared the effects of 

morphology, proliferation, and apoptosis. The resulting data helped to characterize the different flow 
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patterns and nature of the orbiting dishes. For example, they observed an absence of shear stress at 

the middle of the dish as opposed to large shear stress effects at the periphery.  

D. Computational Fluid Dynamics 

While computational fluid dynamics (CFD) originated in the 1940s with the creation of the 

first digital computer, computational fluid dynamics usage began to increase only with the 

advancement of computers and the readily available software in the late 1950’s. Computational fluid 

dynamics is based on transport phenomena, which concerns the transfer of energy, mass, and 

momentum. Computational fluid dynamics software programs offer the advantageous ability to 

instantaneously solve multiple equations that would be inefficient to solve simultaneously otherwise. 

By simultaneously solving the governing transport equations, programs like Fluent, CFX, or Flow 

3D are able to calculate fluid properties and simulate fluid transport.  

Navier-Stokes equations are the governing transport phenomena equations Fluent uses to 

solve for fluid motion. The exact equations used by Fluent when calculating fluid flow are as 

follows: 

For conservation of mass: 

𝜕𝜌

𝜕𝑡
+

𝜕

𝜕𝑥𝑖
(𝜌 ∗ 𝑢𝑖) = 𝑆𝑚     (7) 

For conservation of momentum: 

𝜕

𝜕𝑥𝑖
(𝜌 ∗ 𝑢𝑖) + 

𝜕

𝜕𝑥𝑗
(𝜌 ∗ 𝑢𝑖 ∗ 𝑢𝑗) = −

𝜕𝑝

𝜕𝑥𝑖
+

𝜕𝜏𝑖𝑗

𝜕𝑥𝑗
+ 𝜌 ∗ 𝑔𝑖 + 𝐹𝑖    (8) 

 

For calculating shear stress: 
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      𝜏𝑖𝑗 = [𝜇 (
𝜕𝜏𝑖

𝜕𝑥𝑗
+

𝜕𝜏𝑗

𝜕𝑥𝑖
)] −

2

3
∗ 𝜇 ∗

𝜕𝜏𝑖

𝜕𝑥𝑖
∗ 𝛿𝑖𝑗   (9) 

For conservation of energy: 

𝜕

𝜕𝑡
(𝜌 ∗ ℎ) + 

𝜕

𝜕𝑥𝑖

(𝜌 ∗ 𝑢𝑖 ∗ ℎ) =
𝜕𝑝

𝜕𝑥𝑖
(𝑘 ∗

𝜕𝑇

𝜕𝑥𝑖
) −

𝜕

𝜕𝑥𝑖
∑ℎ𝑗 ∗ 𝐽𝑗 +

𝜕𝑝

𝜕𝑡
+ 𝑢𝑖

𝜕𝑝

𝜕𝑥𝑖

+ 𝜏𝑖𝑗

𝜕𝑢𝑖

𝜕𝑥𝑗

+ 𝑆ℎ 

(10) 

The variables are defined as  

ℎ = ∑ 𝑚𝑖 ∗ ℎ𝑖𝑖       (11) 

ℎ𝑖 = ∫ 𝐶𝑝𝑖𝑑𝑇
𝑇

𝑇𝑟𝑒𝑓
      (12) 

 For conservation of chemical species: 

       
𝜕

𝜕𝑡
(𝜌 ∗ 𝑚𝑖) + 

𝜕

𝜕𝑥𝑖
(𝜌 ∗ 𝑢𝑖 ∗ 𝑚𝑖) =

𝜕

𝜕𝑥𝑖
(𝐽𝑖1,𝑖2) + 𝑆𝑖        (13) 

where the J variable is defined as: 

𝐽𝑖1,𝑖2 = −𝜌 ∗ 𝐷𝑖1,𝑖2 ∗ 𝑚 ∗
𝜕𝑚𝑖

𝜕𝑥𝑖
        (14) 

The equations above are not solved in their partial differential forms, but are reduced to 

algebraic equations using the finite difference method. These simpler algebraic equations can be 

written as: 

∅𝑝 ∑ (𝐴𝑖 − 𝑆𝑝)𝑖 = ∑ 𝐴𝑖∅𝑖 + 𝑆𝑐𝑖         (15) 
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 where the variable A is the coefficient from diffusive and convective fluxes and S variables are 

defined as: 

𝑆∅ = 𝑆𝑐 + 𝑆𝑝 ∗ ∅𝑝         (16) 

With the initial input conditions, Fluent iterates the equations in each cell. Cells are small volumes 

that make up the simulated object. Each cell is treated as a single point with its own fluid properties 

and values. More cells correlate to a higher resolution, however more cells also correlate to longer 

computational times for Fluent.  

The u, v, and w momentum equations are solved using pressure to determine the velocity 

field. If either the velocity field or pressure does not follow the continuity equation, corrections are 

made. Once the pressure and velocities are correct, all other conservation equations are solved based 

on those results. The fluid properties are then updated based on the auxiliary equations. Once the 

difference between successive iteration steps reaches a defined value or a defined number of iteration 

steps the calculation stops.   

The main approach used by CFD to discretize the governing equations is illustrated by a 

simple one dimensional equation: 

𝑑𝑢

𝑑𝑥
+ 𝑢𝑚 = 0; 0 ≤ 𝑥 ≤ 1; 𝑢(0) = 1           (17) 

The variable m helps define both linear (m=1) equations and nonlinear equations (m=2).  

When m=1 in a linear equation, the equation will result in four equally spaced points with ∆x = .33.  

In practice, the CFD process variable will be one of the four points, thus, the governing equation in 

each cell or grid point would be: 

(
𝑑𝑢

𝑑𝑥
)
𝑖
+ 𝑢𝑖 = 0       (18) 
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The Taylor series is also used to solve for the u variable. In the end, all the differential 

equations are converted into distinct linear equations instead of using continuous variables.  

The two finite difference methods most commonly used are finite volume method and finite 

element method.  Fluent uses the finite volume method.  In the Fluent program, the geometries are 

divided into triangles for 2D meshes and tetrahedral, hexahedral, or prism for 3D meshes.  When 

applying the governing equation to each cell volume, the discrete equations used to solve the process 

are created.  The continuity equation for steady state incompressible flow is: 

∫ �⃗� ∙ �̃�𝑑𝑠= 0
𝑆

          (19) 

The S is the surface of the volume and n specifies a normal direction. Similar equations are used for 

discretization of conservation of momentum and energy equations.  

The finite element method is another technique used to discretize.  The finite element method 

identifies boundary conditions for inter-connected regions or elements.  Once the boundary 

conditions have been generated using discretization, the governing equation can be solved for all 

elements.  While this method was originally used to study stress in airframe structures, it has grown 

in popularity with fluid flow systems. Ansys, Adina Feam, and ABAQUS are among the more 

popular finite element software providers. 

E. Types of Shear Stress 

1. Uniaxial Shear 

The effects of different types of shear stress on endothelial cells have been analyzed. 

Examples include uniaxial shear, uniaxial oscillatory shear, and uniaxial pulsatile shear. Steady 

uniaxial shear has been proven to change cell length and orientation by Yamaguchi et al. (1993). In 

their study, a three dimensional CFD case was designed to model the endothelial cell with simulated 
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shear. As the flow was simulated, the change in cell shape was monitored.  The results showed that 

the cells became elongated in the direction of flow. Levesque et al. (1985) directly studied the cell 

effects to define how much elongation and change in orientation of endothelial cells happened in 

response to shear stress. However, unlike Yamaguchi et al, Levesque et al grew cells in the study and 

documented how the cells responded. The response was that the cells became more elongated with 

larger shear stress. Inoguchi et al. (2007) documented that by gradually increasing shear stress, 

endothelial cell detachment decreased with an increase in cell elongation and cell alignment in the 

direction of flow.  Endothelial cell stiffness induced by shear stress was investigated by Sato et al. 

(2000).  As measured by atomic force microscopy, shear stress created cell elongation and nucleus 

movement to the downstream side.  At the six hour exposure mark partial stiffness was noted with 

total stiffness achieved at 24 hours of shear stress.  Zhao et al. (2007) showed that uniaxial wall shear 

stress can cause endothelial cells to align with and elongate in the direction of flow.  It was found 

that together shear stress and hoop stretch created different morphologic response than either alone.   

Chotard-Ghodsnia et al. (2007) studied tumor cell morphology as the tumors interacted with 

endothelial cells primarily under uniaxial flow.  The shear stress not only affected morphology but 

also the mechanical properties of endothelial cells.  For example, the attachment of tumor cells on 

endothelial cells was proven to be shear-dependent.  However, once attached, shear stress had no 

effect on the radial spreading of tumor cells, but did affect axial spreading of tumor cells. The radial 

spreading of the tumor cells equated to migration through the vascular endothelial cells while axially 

meant forming a mosaic tumor endothelial monolayer. In the Fukushima et al. (2001) study, 

endothelial cells were measured by the geometry change of cells as they experienced shear 

stress.  The study used a confocal laser scanning microscopy to determine the shear stress 

distribution and surface geometry change by particle tracking velocimetry.  The study included both 

cells that had experienced fluid flow and static fluid.  The study showed that the shear stress 



12 

 

distribution closely correlated to the surface geometry on a cell and those cells in proximity.  Li et al. 

(2005) also investigated the relationship between shear stress generated by channel flow and cellular 

responses. The study noted that endothelial cells hold the capacity to sense the mechanical stimulus 

of laminar, disturbed, or oscillatory shear stress flows and in turn signal a reaction to other cells. 

They concluded that shear stress must aid in regulation of endothelial cell functions that 

communicate by intercellular signaling networks.  

In a previous study Mailovanova et al. (2004) showed the effects shear stress induced by 

slowing or stopping flow on endothelial cells. A simulated ischemia caused a depolarization of cell 

membranes and an increase production of reactive oxygen species, ultimately showing an increase in 

cellular proliferation efforts of transcription factor activation and faster DNA synthesis.   As a follow 

up, another study was used to evaluate cellular proliferation and to determine the role of activating 

reactive oxygen species.  Milovanova et al. (2006) postulated that the production of reactive oxygen 

species (ROS) are a signal of endothelial cell proliferation associated with shear stress loss.  In the 

end, the study proved that the loss of shear stress in the flow CD31-positive pulmonary 

microvascular endothelial cells resulted in cell division associated with ROS generation.  

Kudo et al. (2003) investigated the long term affects that uniaxial shear stress had on calcium 

response and morphology of endothelial cells.  With time periods ranging from 15 minutes to 24 

hours the study found that while there was an immediate calcium response to initial flow, the calcium 

response subsided with long term shear stress exposure.  When Secomb and Pries (2001) studied the 

transmission of uniaxial shear stress to endothelial cells in blood vessels lined with an endothelial 

surface layer, two significant findings emerged.  First, the transmission of shear stress happens 

mostly at the attachment points of the endothelial surface layer to the cell membrane.  Second, the 

presence of an endothelial surface layer altered the spatial phenomenon of how the cells responded to 

shear stress, decreasing the effects of rapid shear stress fluctuations on endothelial cells.  Slater et al. 
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(2002) studied the effect of hypothermic temperatures on endothelial cells as a way of judging the 

validity of perfusion preservation on a hypothermic liver. Increased cell rounding was observed 

during increases in shear during hypothermic machine perfusion preservation. In addition, the study 

determined that cellular rounding in hypothermic conditions can be discouraged by low machine 

flow rates. Nagayama et al. (1995) studied the morphology and migration of endothelial cells.  The 

results suggested that the initial orientation and shape of the cells affected how external shear stress 

was responded to.  This response was theorized as an organizational effect due to the interaction of 

neighboring cells.  Similarly, Tanishita et al. (1999) studied the morphology and migration of 

individual cultured cell with wall shear stress of 3 and 5 Pascals.  Using a microscope they were able 

to observe that the original orientation and shape of the cells affected the receiving of external shear 

stress.  Because cell shape depends on surrounding cells the external shear stress stimulus resulted in 

a small grouping behavior.   

Fernandez et al. (2006) studied the effects of uniaxial shear stress on endothelial cells when 

seeded on vascular grafts.  The results proved that seeded endothelial cells do transduce shear stress 

in closed clinical conditions. Their positive results provided new insights into vascular tissue 

engineering. Some scientists believe that seeding autologous endothelial cells onto the lumen of the 

vessel prior to implantation will improve long-term patency of vascular prosthesis. This involves pre-

treating the prosthesis material with fibrin, collagen, or other matrix molecules to encourage cell 

attachment and retention. It was documented by Feugier et al. (2005) that the ability to adhere to the 

cells depended on the coating.  In some cases fewer than 30% of the cells remain after only one hour 

exposure to physiological levels of shear stress.  Vascular endothelial cells are consistently subjected 

to shear stress and neighboring smooth muscle cells.  Chiu at el. (2004) developed a study to 

document the effects of shear stress on endothelial cells (ECs) and neighboring smooth muscle cell 

(SMC) interactions.  When co-cultured SMCs were exposed to a shear stress magnitude of 12 
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dynes/cm2, the cells tended to orient perpendicular to flow.  This orientation was not observed when 

exposed to 2 dynes/cm2.  This observation along with others suggested that shear stress serves as a 

down-regulator for the pathophysiological gene expression of ECs co-cultured with SMCs. Cellular 

permeability affected by shear stress has been important topic for researchers. The shear stress by 

acting on the endothelial cell walls affects cellular permeability. Sakamoto et al. (2004) studied the 

effects of shear stress on permeability of the endothelial monolayer using a co-culture model of 

endothelial cells and smooth muscle cells. Similar to Chiu et al. (2004) the results suggested that 

cellular interaction between ECs and SMCs were effected by permeability thus shear stress. Drug 

delivery systems require the ability to predict the environment-specific responses of target cells. In a 

study done by Hughes et al. (2005) it was observed that endothelial cell migration into a scrape 

wound was enhanced in sphingosine 1-phosphate by shear stress. In the same study vascular 

endothelial growth factor stimulated human umbilical vein endothelial cells to migrate into a scrape 

wound by the addition of shear stress.  Tang et al. (2002) was able to utilize 3-D computational 

modeling in combination with experimental data to better understand shear stress distribution on 

endothelial cell membranes. 

2. Uniaxial Oscillatory Shear 

The effect of uniaxial oscillatory shear had varying effects on human cells.  Chappell at el. 

(1998) investigated uniaxial oscillatory shear on adhesion molecule expressions for endothelial cells.  

The study showed that the shear stimulated adhesion of mononuclear leukocyte cells and increased 

migration into the arterial wall. Ku et al. (1985) discovered the impact of shear reversals on 

atherosclerotic plaque formation in human carotid bifurcation. In order to understand the effects of 

oscillatory shear index, the OSI variable was developed in order to help measure the reversal of shear 

in the study: 
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𝑂𝑆𝐼 = 1 −
| ∫ 𝜏𝑤⃗⃗ ⃗⃗  ⃗𝑑𝑡 |

𝑇
0

∫ |𝜏𝑤⃗⃗ ⃗⃗  ⃗ |𝑑𝑡
𝑇
0

      (19) 

OSI is zero for steady one directional flow but unity for fully reversing or oscillatory flow.  

Specifically in the Ku et al. experiments, shear stress at five axial and four circumferential positions 

were correlated to intimal plaque thickness. They found a strong correlation between OSI and intimal 

thickness.  As a follow up to Ku at el. (1985) study Ding et al. (2001) sought to vary the correlation 

and determine whether the correlation could be improved by a tuning fork shaped model that more 

closely modeled an average human carotid bifurcation. The conclusion of the study was that the TF-

shaped model was closer to human carotid bifurcation.  Additionally there was a strong positive 

correlation between OSI and intimal thickness.  The TF-shaped model was an improvement over the 

traditional Y-shaped model.   

3. Uniaxial Pulsatile Shear 

Pulsating shear has also been shown to affect cellular responses.  Owatverot et al. (2005) 

found that the pulsating flow has a strong effect on cell orientation.  Their study showed that both 

magnitude and direction of the cycling flow individually produced a cell response.  In another study 

Hsiai et al. (2002) discovered that pulsating shear did a better job at elongating and realigning cells 

than non-pulsing shear.  Laminar flow is the predominate flow regime in biological systems but can 

appear as turbulent in special cases.  Because of this fact there have been investigations comparing 

the effects of laminar and turbulent shear stress.  In a study by Davies et al. (1986) the comparison of 

laminar and turbulent pulsatile flow on vascular endothelial cells resulted in the understanding that 

the unsteady blood flow characteristic, not the magnitude of wall shear stress, was the major 

contributor of shear-induced endothelial turnover.  This conclusion was achieved by exposing 
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endothelial cells to laminar shear stress ranging from 8 – 15 dynes/cm2 for 24 hours and turbulent 

shear stress as low as 1.5 dynes/cm2 for 3 hours.  

He and Ku (1996) focused on understanding localization of atherosclerosis thought to be 

governed by local hemodynamic forces.  The pulsatile hemodynamics of the left coronary artery 

bifurcations was numerically simulated using the spectral element method.  It was observed that 

velocity skewing arose from bifurcation and curvature of the artery.  As was expected the arterial 

wall shear stress was significantly lower in the bifurcation region, with the largest oscillatory 

behavior concentrating on the outer wall of the artery. Frangos et al. (1988) used a flow apparatus to 

subject endothelial cells to steady and pulsatile shear stress.  The study demonstrated that the shear 

stress in certain ranges may not harm mammalian cell metabolism.  Furthermore, according to the 

research metabolite production is maximized by maximizing shear stress. Chien et al. (2001) 

presented a study analyzing endothelial cells in a dynamic state and response to alternations in shear 

stress by signal events that influence their performance. Himburg et al. (2007) showed that 

inflammatory response of endothelial cells evoked by higher frequency of shear stress became more 

pronounced by reversing and oscillatory shear.  This lead to the conclusion that an arterial region 

subjected to both shear reversal and dominant frequencies of shear stress that exceed the normal heart 

rate are at greater risk to health issues like atherosclerotic lesion development. Hwang et al. (2003) 

further studied the effects of pulsatile and oscillatory shear stress on NADPH oxidase expression.  

They subjected bovine aortic endothelial cells to various magnitudes of shear stress that were 

pulsatile and oscillatory in nature.  In the end the study showed that the oscillatory shear stress 

creates greater oxidative stress by O2 production, thus enhances LDL oxidation and upped regulation 

of inflammatory markers.  Prior to Barabac et al. (2006), it was understood that bone mass and 

structure changed in response to changes in mechanical loading, however, it was not understood how 
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the cells sense the vibration stress.  Barabec et al. showed a path or correlation between nitric oxide 

and prostaglandin E2 would provide a way for the cellular mechanosensing of loading. 

F. DOSI 

Chakraborty (2012) created DOSI (directional oscillatory shear stress) to compensate for the 

bidirectional motion of oscillating dishes. DOSI was defined as:  

𝐷𝑂𝑆𝐼 = 1 −
𝑂𝑆𝐼2

𝑂𝑆𝐼1
          (20) 

𝑂𝑆𝐼1 = 1 −
| ∫ 𝜏1⃗⃗⃗⃗ 𝑑𝑡 |

𝑇
0

∫ |𝜏𝑤⃗⃗ ⃗⃗  ⃗ |𝑑𝑡
𝑇
0

       (21)  

𝑂𝑆𝐼2 = 1 −
| ∫ 𝜏2⃗⃗⃗⃗ 𝑑𝑡 |

𝑇
0

∫ |𝜏𝑤⃗⃗ ⃗⃗  ⃗ |𝑑𝑡
𝑇
0

      (22) 

∫ 𝜏1𝜏2𝑑𝑡
𝑇

0
= 0       (23) 

The numerical subscripts specify the vector direction of primary and secondary directions. 

The Taus (𝜏1 , 𝜏2 ) represent shear stress in a particular direction with 𝜏1being greater in magnitude.  

The 𝜏𝑤 represents the combined or resultant shear stress. DOSI is zero when oscillations in both 

directions are equal in magnitude and unity for uniaxial shear whether there is a reversal or not.  As 

𝑂𝑆𝐼1  and 𝑂𝑆𝐼2 approach zero the larger of the two will always occupy the denominator. Chakraborty 

(2011) investigated the effects of oscillatory wall shear stress on endothelial cellular responses like 

cell proliferation, morphology, and athergenic gene expression.  The comprehensive statistical 

analysis showed that DOSI was the strongest determinant of proliferation, area, shape index, and 

angle of cell orientation. 



18 

 

G. Dimensionless Parameters  

The scientist Osborne Reynolds in 1883 succeeded in demonstrating the difference between 

low pressure drops at low flow rates and disproportionally high pressure drops at high flow rates.  

Reynolds set up a control by flowing water through a glass tank.  By adding a stream of colored 

water, Reynolds made it possible to see how the water flowed through the tank.  Reynolds found that 

at low Reynolds numbers the stream of colored water stayed together through the pipe, however at 

high Reynolds numbers flow rates the dye would diffuse through the clear water flow.   

The motion type at low flow rates is called laminar flow.  Laminar flow describes fluids 

without lateral mixing in which the layers slide past each other.  The second type of flow regime 

called turbulent flow, has high flow rates and is characterized by cross-currents and eddies.  Eddies 

are swirls in the fluid that allow for a greater amount of energy transfer.  Because of the chaotic 

nature of the eddies, mixing increases in all directions.   

Because of this research, a dimensionless variable named Reynolds number was developed.  

Although the Reynolds equation changes for different flow geometries, the Reynolds equation for 

flow in a pipe is: 

       𝑅𝑒 =
𝑣∗𝐷

𝜈
     (24) 

The Reynolds number is classified as a ratio of inertial forces to the viscous forces.  Under 

the conditions of a flat plate flow, turbulent flow starts at around 105 and becomes fully developed by 

3 x 106.  Since Reynolds number was defined, several empirical equations have adopted the variable 

into equations to solve for other variables.  For example, for pipe flow applications the amount of 

friction, which affects phenomena such as pressure drop of a fluid, are determined as functions of 

Reynolds number.   
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As the properties surrounding interactions with a flowing fluid change the Reynolds number 

takes different forms.  For example, in mixing tanks the Reynolds equation changes to: 

𝑅𝑒 =  
𝑁∗𝐷2∗𝜌

𝜇
       (25) 

 In the equation N is the impeller speed, in rev/s, and d is the impeller diameter.  Based on this 

equation the transition from laminar to turbulent occurs between a Reynolds numbers of 50 to 5000.  

For the Petri dish, the characteristic velocity is the orbital speed (𝜔) and the characteristic dimension 

of the fluid is height (H), so the Reynolds number is:  

                                               𝑅𝑒 =  
𝐻∗𝑎∗𝜔∗𝜌

𝑣
          (26) 

  The mathematician George Gabriel Stokes developed the Stokes Number among other 

famous equations such as the Navies-Stokes equations.  It was in 1845 that he began studying friction 

on fluids in motion.  Stokes developed a law that defined the frictional force exerted on spherical 

objects in a viscous fluid. In orbital dishes, it is defined as the ratio of inertial forces from the dishes 

versus the viscous forces from the fluid:   

𝑆𝑡 = 𝐻 ∗ √
𝜔

𝑣
          (28) 

For low Stokes Number, the fluid motion will be viscous dominated, for high Stokes Number 

the flow will be unsteady.   

The Froude number was developed by the English engineer, William Froude.  He studied the 

stability of ships in a seaway in 1861.  The Froude number he developed arose from his 

quantification of resistance of floating objects.  More specifically the Froude Number compares 

inertial and gravitational forces and is defined as a ratio of speed/length:  
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𝐹𝑟 =
𝑢

√𝑔∗𝐻
        (29) 

For low Froude Numbers, the leading edge has the same slope as the rest of the leading edge 

of the wave. At a value of one the fluid reaches standing wave.  For high Froude Numbers (or when 

Froude is greater than one), the front wave becomes unsteady and crashes similar to the shape and 

motion of waves on a beach. Because determining the actual speed of the fluid is difficult in the dish, 

past experiments have define this term by multiplying revolution speed (𝜔) and characteristic width 

(𝑎). (Fluid velocity would be a function of both of these terms.) 

The slope ratio is used to measure the steepness of the free surface of the fluid in the dish.  

For these cases the slope ratio is defined as the ratio of the quasi-steady free surface slope and the 

aspect ratio of the fluid at rest:  

         𝑆𝑙 =
𝑅∗𝑎∗𝜔2

𝑔∗𝐻
                                  (30) 

A new dimensionless variable surrounding wall shear stress was utilized. This new variable 

will be referred to as dimensionless shear (DS). Dimensionless shear is the ratio of wall shear stress 

calculated by Fluent (Equation 8) to shear stress calculated by Equation 6:  

         𝜏𝐷𝐻 =
𝜏𝑖𝑗

𝜏𝑤𝑠𝑠
                                 (30) 

All of the dimensionless variables depend on the fluid height. While convention and past 

experiments dictate what the fluid height is in the conventional dish, the new geometries require a 

different approach. When studying open channel flow, a concept that is similar to the fluid path in the 

narrow channel dishes, the fluid height is defined as the hydraulic depth. This is a ratio of the area of 
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the channel’s cross section to the wetted wall perimeter of the channel. This same definition will be 

utilized to define fluid height in the narrow channel dishes and is displayed below:  

         𝐷𝐻 =
𝐴

𝑊𝑃
                                  (30) 
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III. RESEARCH METHODS  

A. Simulation Plan 

The three geometries consist of a narrow-channel flat bottom dish (NCF), narrow-channel 

banked bottom (NCB) dish, and conventional cylinder Petri dish.  Dimensions of the tested 

geometries are displayed in the following three figures.   

 

FIGURE 1 – Narrow-Channel Flat Bottom Dish 
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FIGURE 2 – Narrow-Channel Banked Bottom Dish 

 

FIGURE 3 – Conventional Dish 

As this study is a follow up on previous studies such as Chakraborty (2011), Thomas (2007), 

and Berson et al. (2008) it was necessary to mimic various design specifications in those studies. The 

pertinent variables from those studies that were used here are: rotational speeds of 60RPM, 90RPM, 

120 RPM, 150 RPM, 180 RPM; outer dish radii of 35 mm; water height of 2 mm; orbital radius of 

9.5mm, and liquid density and viscosity of water. 
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Past simulation work plans were designed based on dimensionless parameter values. 

However, manipulation of the independent variables (kinematic viscosity, orbital speed, etc.) for the 

dimensionless variables sometimes creates physically unrealistic values. To study only physically 

relevant values, the dimensionless variables were not used as a basis for work plan, limiting some 

comparisons. Values are generally within the ranges used previously. For example, Thomas (2007) 

ran cases for a range of Stokes number of 1 – 10, Froude number of .1 to 1.2, and a slope ratio of .1 

to 10. The calculated dimensionless variables are in Table I below. 

The slope ratio number required modification for the NCB cases, to account for the angle of 

the bottom of the banked bottom dish. In theory because of the banked bottom being a 45 degree 

angle, the slope ratio should approach unity at resting and decreases as orbital speed increases. The 

new equation satisfies this phenomenon: 

             𝑆𝑙𝑚𝑜𝑑 = 1 − 
𝑅∗𝜔2

tan 𝜃∗𝑔
                                (31) 
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TABLE I – Dimensionless Variables 

 Orbital Speed Stokes Slope Froude Reynolds 

Narrow Channel 

Flat 

60 0.06 0.12 0.18 0.01 

90 0.22 0.28 0.27 0.15 

120 0.56 0.50 0.36 1.01 

150 0.76 0.78 0.45 1.89 

180 0.96 1.12 0.54 3.03 

Narrow Channel 

Banked 

60 0.03 0.96 0.13 0.003 

90 0.12 0.91 0.19 0.04 

120 0.30 0.85 0.26 0.29 

150 0.41 0.76 0.32 0.53 

180 0.52 0.66 0.39 0.86 

Conventional 

60 0.14 0.33 0.78 0.18 

90 0.56 0.75 1.18 2.75 

120 1.45 1.34 1.57 18.36 

150 1.98 2.09 1.96 34.42 

180 2.51 3.01 2.35 55.07 

 

B. Software 

Fluent was the CFD software used for the simulations. The Speed School of Engineering’s 

Adelie Computer network, a 64 Linux cluster parallel system based on the AMD Opteron processor 

was used to run Fluent. The operating system was SUSE LINUX 9.1 Professional Edition. The two 
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main Adelie advantages are the ability to run multiple cases and processing speed. The system 

consists of 6 nodes with a total 12 processors yielding 43 Gigaflops of combined processor speed.   

A user defined function (UDF) was developed to generate the motion of a shaker plate.  The 

counter clockwise orbit of the dish was specified in terms of orbital frequency, center of orbit, and 

orbital radius.  The UDF is read into Fluent as a part of the moving dynamic mesh capability.  The 

UDF was especially useful due to the unsteady state flow and need for the dynamic mesh to move 

through space.  The UDF code can be found in APPENDIX A. 

The free motion of the fluid requires tracking of the liquid-air interface which was accomplished 

with the Volume of Fluid model.  In this model the two fluids (water and air) share a single set of 

momentum equations and the volume fraction of each fluid in each computation cell is tracked.   

C. Create Dish in Fluent 

The profile of the geometries were created and then rotated around a central axis using Fluent’s 

extraction feature. Once the cylinders were created, a computational mesh was applied.  Berson et al 

(2008) determined the optimum mesh count at 300,000 hex shaped cells.  Thus the standard dish was 

also set at that cell count here.  The cell count for the narrow-channel dishes were first set to a 

proportional number based on volume. In order to determine the best dimensions of the mesh several 

cases were run in order to get an approximation of time and mesh size needed to approach steady 

state. Meshes of differing height and thickness and number of revolutions were examined.  The cases 

were run until increases in cell number showed no variation in predicted shear stress average, shear 

stress maximums, and shear contour appearance. Table III through VIII in APPENDIX B and 

Figures 4 through 8 represent the totality of cases run to verify the best mesh size and run time. After 

running cases 1 – 29, four were selected (30-33) based on ending average shear stress and maximum 

shear stress values. The ending values were chosen based on the high cell mesh cases 15 – 21. The 
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values shown in the tables were 0.88 dynes/cm2 for average shear and 2.1 dynes/cm2 for maximum 

shear. Each of the four cases chosen for further analysis had the required shear stress values but had a 

decreased number of cells because small meshes result in smaller computational time. The results 

were: case 30 had 168600 cells, average shear of .88 dynes/cm2, and maximum shear of 2.15 

dynes/cm2, case 31 had 73712 cells, average shear of .83 dynes/cm2, and maximum shear of 2.05 

dynes/cm2, case 32 had 172346 cells, average shear of .89 dynes/cm2, and maximum shear of 2.12 

dynes/cm2, case 33 had 245500 cells, average shear of .89 dynes/cm2, and maximum shear of 2.12 

dynes/cm2. The four cases were then run while saving time steps.  The results show, that no matter 

which mesh, after one revolution shear stress values for average and maximum had stabilized. In the 

end for the narrow channel dishes around 170,000 cells per mesh were selected and 2 complete 

revolutions.  The results are shown in Figures 4-8 below. 

 

FIGURE 4 – Average Shear Vs Number of Cells 
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FIGURE 5 – Shear Stress vs Time for 168600 Cells (30) 

 

 

FIGURE 6 – Shear Stress vs Time for 73712 Cells (31) 
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FIGURE 7 – Shear Stress vs Time for 173200 Cells (32) 

 

 

FIGURE 8 – Shear Stress vs Time For 245500 Cells (33) 

 

 

 

0

0.5

1

1.5

2

2.5

0 1 2 3 4

Sh
e

ar
 S

tr
e

ss
 (

d
yn

e
/c

m
2
) 

 

Seconds 

Max

Average

0

0.5

1

1.5

2

2.5

0 1 2 3 4

Sh
e

ar
 S

tr
e

ss
 (

d
yn

e
/c

m
2
) 

Seconds  

Max

Average



30 

 

D. Set-Up Fluent Case 

1.  Import the mesh 

Open the 3D version> File > Read > Case (a Select File window will open.) > Select the appropriate 

.msh file. 

 

FIGURE 9 –Select File Window 

2. Correct Units 

Fluent will assume that your mesh dimensions are consistent with Fluent’s default settings.  If the 

default is the same as the original size the unit will not need to be corrected.  Otherwise, click Grid > 

Scale > Scale Grid window (click down arrow, select “cm”, then click on Change Length Units > 

Scale > Close.   
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FIGURE 10 – Scale Mesh Window 

3. Modeling Technique  

The user must provide Fluent with information about the initial phases and modeling technique for 

each particular case.  During this experiment there were two phases water and air. Click Define >  

Models > multiphase > Model > Volume of Fluid > OK. 

 

 

FIGURE 11 – Multiphase Model Window 
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4. Specify Fluid Properties 

The create/edit material interface allows the user to manipulate the properties of the fluids in the 

case.  This allows for the creation of new materials with set properties or a selection of materials 

from a database.  

 

FIGURE 12 – Create/Edit Materials Window 

Click Define > Material > Fluent Database > Scroll down under Fluent Fluid Materials > Select 

water-liquid > Copy > Close 

5. Assign materials to phases 

The user can name each phase material for easy reference. Click Define > Phases > set primary phase 

to air and secondary to water 

 

FIGURE 13 – Secondary Phase Window 
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6. Gravity 

The direction and magnitude of gravity is important and must be set properly to insure realistic 

results.  Click Gravity > Gravitational Acceleration > -9.81 m/s2 for z component > OK 

 

FIGURE 14 – Gravity Window 

7. Add Motion to Library and mesh 

The orbiting motion of the dishes specific to shaker plates has to be created.  The coding for the UDF 

can be found in APPENDIX A. Once Fluent has been updated with the motion it must then be 

assigned to the mesh.   

 

FIGURE 15 – Compiled UDFs Window 

Click Define > User-Defined > Functions > Compiled > Sources Files > Add > Select UDF file > 

OK  
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FIGURE 16 – Dynamics Mesh Zones Window 

Define > Dynamic Mesh > Create/Edit > Specific a Zone > Specific a Dynamic Mesh Zone > Select 

Motion UDF/ Profile > Create > close 

8. Solution Methods 

The Navier-Stokes equations provide Fluent with set method to calculate the fluid dynamics of the 

cases further specification of the exact methods can be entered through solution controls.   
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FIGURE 17 – Solution Methods 

Solution Methods: Change Pressure-Velocity Coupling Scheme to PISO; Gradient to Green-Gauss 

Cell Based; Pressure to Body Force Weighted; Momentum to Quick; Volume Fraction to Geo-

Reconstruct  

Solution Controls > Change all Under-Relaxation Factors to 0.3  

 

FIGURE 18 – Under-Relaxation Factors Window 

 

Monitors > Select Residuals – Print > Create > Change Absolute Criteria to .0001 
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FIGURE 19 – Residual Monitors Window 

9. Patch in the Water Phase 

The fluids present in the model must be patched to the appropriate region.  Patching consist of 

specifying a region for a specified material to occupy. 

Click Solve > Initialize > Click initialize  

 

FIGURE 20 – Initial Values Window 

Select Adapt > Region > Input Coordinates > Input X Y and Z, Min and Max > Mark > Solve > 

Initialize > Patch > water value 1 > Registers hexahedron-r0 > Patch  
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FIGURE 21 – Region Adaption Window  

10. Completing Fluent Set-Up 

Calculation Activities > Set Autosave ( E.g. 205)>  Run Calculation > Set Time Step Size to .001  

File > Write > Case and Data File 

11. Set-up Batch Run 

A batch run consists of running the case in the background of the Adelie system. Two files are 

needed to run a Fluent case this way, a batch file and an input file.  The batch file opens Fluent to 

initiate the run.  The sixth line of the batch file indicates the file locations where the input file is read. 

The seventh line specifies the file location where the output file is written. Once initiated, the input 

file dictates more Fluent operating conditions.  For example, line one loads the initial case file, line 

two loads the initial data file, line five sets the number of time steps, line six sets the number of 

iterations per time step, line seven records the final case file, and line seven records the final data file.  

An example batch and input file are located in APPENDIX A.  
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E.  Analyzing Data 

To display shear contours: Graphics and Animations > Contours > Contours of Wall Fluxes 

 

To export data to use for DOSI calculations in a spreadsheet: 

File > Export > Solution Data > File Type - ASCII > Surfaces – (select appropriate surface) > 

Quantities – (specify all quantities needed)  

FIGURE 22 – Contours Windows 

 

FIGURE 23 – Export Data Window 
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IV. RESULTS AND DISCUSSION OF RESULTS 

A. General Discussion 

The geometries were evaluated by shear stress contours, tangential vs radial plots, trend line 

slopes, and DOSI values. The shear stress contours consist of the shear stress at the bottom surface, 

of each geometry. The shear contours are beneficial because they provide a simple way to visual 

inspect shear magnitudes and patterns. Figure 24 shows shear stress contours for each dish. 

Surprisingly, the shear stress values were similar in magnitudes among the dish. In the figure, the 

contours are shown for an orbital speed of 180 RPM. The ranges for the conventional dish data 

(right) were from 0 – 22 dynes/cm2, for NCF dish (left) were from 0 – 20 dynes/cm2, and for the 

NCB dish (middle) were from 0 – 26 dynes/cm2. In the following sections the shear contours will be 

displayed with dimensionless shear but contours displayed with normal shear stress are available in 

APPENDIX B Figures 96 - 110. In conjunction with the dimensionless shear contours are the 

dimensionless shear vs RPM plots. These plots display the average dimensionless shear a cell would 

experience at each radial location (Figures 30, 42, and 55). These plots are beneficial because they 

easily show the variation in shear between the different radial locations.    

     

FIGURE 24 – Comparison of Shear Contours for NCF dish (left), and NCB dish (middle), and 

Conventional dish (right) 
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  The complete set of tangential vs radial plots can be found in APPENDIX B: NCF dishes in 

Figures 66 - 75, NCB dishes in Figures 76 - 85, and conventional dishes in Figure 86 - 95. A few 

select cases appear in the following sections for discussion (Figures 31 – 32, 43 – 44, and 56 – 59). 

The tangential vs shear plots visually show the direction of shear on the bottom dish surfaces. In the 

plots a circular or elliptical plot represents oscillatory flow while a stretch towards either axis 

represents a shift towards more uniaxial flow.  For example, Figures 31- 32 and 43 - 44 show the 

elongation towards tangential flow that occurs in both NCF and NCB dishes. The conventional dish 

cases, Figure 56 - 59, show a circular shape at lower radial locations, and then elongate towards 

tangential flow at larger radii.  

A key objective of this experiment was to analyze DOSI trends in the novel dishes. 

Determining DOSI first required determining the principal flow direction. The primary direction was 

determined by line fitting the vector components in plots like Figures 66 – 95. These plots display the 

tangential and radial directions for each case of flow in the orbiting dishes. The slope of the trend line 

produced by linear curve fitting provided a numerical representation of the resultant vector or 

primary direction for the DOSI calculation. The numerical relationship is beneficial because it 

provided a simple method for identifying increases or decreases in directional favored flow. This is 

why the slope trend lines along with the DOSI values were analyzed.  

Lastly, DOSI was determined to help identify the degree of oscillation in the novel geometry 

dishes. Each dish had different DOSI values patterns that varied with orbital speed.  
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B. NCF Shear Stress Contours 

Several observations can be made surrounding the differences in the shear stress contours as 

orbital speed increases. First, the shear stress magnitude increased as expected with increasing orbital 

speed. The maximum shear stress increased a full order of magnitude from 2.4 dynes/cm2 at 60 RPM 

to 20 dynes/cm2 at 180 RPM in the NCF dish. (These magnitudes can be seen on the contours in 

APPENDIX B Figures 96 – 100 that display actual shear stress.) Second, the location of the 

maximum shear shifted as orbital speed increased. Only at the lowest orbital speed did the maximum 

shear location approach the inner wall. As the orbital speed increased (90, 120, 150, and 180) the 

maximum shear was pushed outwards, concentrating in the middle of the gap, and a larger portion of 

the fluid had higher shear (darker orange and red colors).  

The dimensionless shear stress contours of the narrow channel flat dish can be seen in 

Figures 25-29. Similar to the actual shear contours, the dimensionless shear contours for the NCF 

dish changed as orbital speed increased. At 60 RPM there was concentrated spot of higher 

dimensionless shear (greater than 0.5) but the majority of dimensionless shear had low values(less 

than 0.5). As orbital speed increased more of the dimensionless contour values became higher; 

however, after 120 RPM as the orbital speed continued to increase the dimensionless shear 

decreased. The increase and then decrease indicates that the viscous favored shear prediction 

equation (6) worked best at 120 RPM because the 120 RPM case had the largest area of 

dimensionless shear values close to one. Another observation about the dimensionless shear contours 

is that in the NCF dishes there is a second region with a magnitude close to half the maximum of the 

main wave, in each respective speed case. For example, in the NCF 120 RPM case the maximum 

dimensionless shear was close to 1 while the second region was roughly 0.5. This second region’s 

area decreased as the orbital speed increased. To examine how dimensionless shear changes based on 

radial location a plot was prepared as seen in Figure 30. The plot shows the average magnitude of 
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dimensionless shear experienced at each location and orbital speed. The dimensionless shear 

averages are clearly less than one. This means Equation 6, the viscous shear equation prediction, is 

not accurate for determining shear in the NCF dish. For the NCF dish the average dimensionless 

shear values only ranged from 0.163 to 0.485. Despite the averages not approaching one, a visual 

inspection of the shear contours showed that the dimensionless shear, in the main fluid wave, did 

approach one in some places. The reason the viscous shear equation under predicts the magnitude of 

shear stress is most likely due to wall affects. As stated previously, the viscous favor shear equation 

is most accurate for flat orbiting planes (no wall affects) with low dimensionless variables. The 

dimensionless variables for the NCF dish were sufficiently low but had multiple walls. The presence 

of walls must have constricted fluid flow and decreased the shear stress. Based on the results from 

the average dimensionless shear values and shear contours, it’s logical to conclude that Equation 6 is 

not an adequate equation for calculating shear stress in the NCF dish at these conditions.  

Another observation surrounding dimensionless shear is shown in Figure 30. For each radii, 

across all orbital speeds, the average dimensionless shear values remained steady. Figure 30 also 

helps easily quantify the differences between radial locations. For example, at 120 RPM the 

maximum variation in dimensionless shear occurred between the 60% location and 10% location 

with values of 0.485 and 0.163, respectively. This means the average dimensionless shear stress 

differed by approximately a multiple of three between these two locations. The remaining orbital 

speeds had smaller but still significant differences in average dimensionless shear among radial 

locations. The least variation occurred at 60 RPM but still had a maximum difference that was close 

to a multiple of two. This means that at the parameters run, shear stress varies significantly in the 

NCF dish.  
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FIGURE 25 – Narrow Channel Flat Dish Dimensionless Shear Stress Contour 60 RPM (Stokes: 0.06, 

Slope: 0.12, Froude: 0.18, and Reynolds: 0.01) 

 

FIGURE 26 – Narrow Channel Flat Dish Dimensionless Shear Stress Contour 90 RPM (Stokes: 0.22, 

Slope: 0.28, Froude: 0.27, and Reynolds: 0.15) 
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FIGURE 27 – Narrow Channel Flat Dish Dimensionless Shear Stress Contour 120 RPM (Stokes: 

0.56, Slope: 0.5, Froude: 0.36, and Reynolds: 1.01) 

 

 

FIGURE 28 – Narrow Channel Flat Dish Dimensionless Shear Stress Contour 150 RPM (Stokes: 

0.76, Slope: 0.78, Froude: 0.45, and Reynolds: 1.89) 
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FIGURE 29 – Narrow Channel Flat Dish Shear Stress Dimensionless Contour 180 RPM (Stokes: 

0.96, Slope: 1.12, Froude: 0.54, and Reynolds: 3.03) 

 

         

FIGURE 30 – Narrow Channel Flat Dish Average Dimensionless Shear Stress vs RPM 
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C. NCF Tangential vs Radial Plots 

For the NCF dish cases the shear stress magnitudes reached a maximum closer to the center of 

the gap and decreased as the fluid approached the inner and outer wall. This was highlighted in the 

previous section and here in Figures 31 - 32. This basic trend was consistent at all orbital speeds (as 

seen in APPENDIX B Figures 66 – 75). The benefit of the tangential vs radial plots are their ability 

to pinpoint the direction of directional favored flow. In this case the tangential vs radial plots show 

the important result that the narrow channel flat dish provided uniaxial (tangential) favored shear 

stress at all radial locations, as opposed to bidirectional flow and tangential flow in conventional 

dishes, (Thomas (2007)). This was deduced from the elongated plots that stretch in the tangential 

direction. This characteristic of the narrow channel flat dishes is a key benefit. 

 

FIGURE 31 – Narrow Channel Flat Dish 150 RPM Graph At 10%, 20, and 40% 
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FIGURE 32 – Narrow Channel Flat Dish 150 RPM Graph At 60%, 80%, And 90% 

D. NCF Trend Line Slopes 

An example showing a graphical representation of the trend lines for the NCF dish is 

displayed in Figure 33, for the 150 RPM case. (All the slope data for each case can be found in 

APPENDIX B in Table II.) The slopes are identified at only 40%, 80% and 90% locations, which 

highlight the overall trends while reducing clutter on the graphs. For the NCF dish the absolute 

values of the slopes, for the specified locations increased from 3.899 to 6.712 to 14.308. This means 

that the slopes gradually became more vertical as radial location increased. This indicates a 

progression towards tangential flow with increasing radii.   (Note: The actual slope values, which 

may include negative values, are presented in APPENDIX B while absolute values are used in the 

Discussion.) 
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FIGURE 33 - Narrow Channel Flat Dish 150 RPM At 40%, 80%, and 90% 

To highlight patterns between orbital speeds, scatter plots were prepared for each geometry. 

The NCF dish data showed a general increase in slope as speed increased (Figure 34). Furthermore, 

for a given orbital speed the slope values were at a minimum at the center and increased towards 

either wall. For example for NCF dish at 120 RPM the values are: 8.25 at 10%, 3.76 at 20%, 3.28 at 

40%, 3.81 at 60%, 6.05 at 80%, and 11.64 at 90%.  
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FIGURE 34- NCF Dish Slope Values VS Radial Location 

E. NCF DOSI Vs Location 

The NCF dish has less variation in DOSI values within a particular orbital speed, as speed 

increased. The ranges for NCF’s DOSI values averaged to be 0.26 at 10% and 0.54 at 60% (both of 

which correspond respectively to the minimum and maximum DOSI values). These values are 

displayed graphically in Figure 35. The data show that less oscillation between the two primary 

directions occurred near the center of the narrow channel gap. In past experiments the DOSI values 

varied with radial location differently (Charkraborty et al (2011)). In that study, the normal trend 

increased from ~0 close to the 0% radial location to  ~ 1 close to the 100% radial location. This new 

trend is promising as it proves low variation in oscillation is possible within a dish.   
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FIGURE 35 – Narrow Channel Flat Dish DOSI vs Location Graph 

F. NCB Shear Stress Contours 

The following were observations made surrounding the differences in the shear stress 

contours as orbital speed increases. First, the shear stress magnitude increased with increasing orbital 

speed.  The maximum shear stress increased on the order of six times from the lowest orbital speed to 

the highest orbital speed. The maximum shear stress magnitude was around 6 dynes/cm2 at 60 RPM 

and 39 dynes/cm2 at 180 RPM. (These magnitudes can be seen on the contours in APPENDIX B 

Figures 101 – 105 that display actual shear stress.). Second, at the lowest orbital speed (60 RPM) the 

shear reached a maximum at a concentrated spot. As the orbital speed increased (90 RPM, 120RPM, 

150 RPM, and 180 RPM) the concentrated spot extended further back into the following fluid, 

concentrating along the outer wall.  

Dimensionless shear contours for the narrow channel banked bottom dishes are seen in 

Figures 36 – 40.  Similar to the actual shear contours, the dimensionless shear contours for the NCB 

dish changed depending on the orbital speed. At 60 RPM, 150 RPM, and 180 RPM the contours 
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value (green in color). At 90 RPM and 120 RPM an elongated region contained the highest shear. To 

examine how dimensionless shear changed based on radial location a plot was prepared as seen in 

Figure 42. . On the figure at 90 RPM, 120 RPM, 150RPM, and 180 RPM the average dimensionless 

shear increases as radial location increases but at the 90% radial location it then decreases to less than 

the 40% radial location. The reason for this is most likely due to the drying phenomenon. Figure 41 

displays phase contours for the NCB dish. These contours show that drying was present and that the 

amount of dry area increased as orbital speed increased Drying caused shear values to approach zero. 

The significant area that was dry (shown in Figure 41) causes the average dimensionless shear at the 

90% radial location to decrease.  

Figure 42 highlights the significant numerical differences in shear between radial locations. 

For example, at 60 RPM the maximum variation in dimensionless shear occurred between the 40% 

location and 90% location with an average value of 0.711 and 0.246, respectively. This means the 

average shear stress differed by approximately a multiple of three between these two locations. The 

remaining orbital speeds had smaller but still significant differences in average dimensionless shear 

among radial locations. The least variation occurred at 90 RPM but still had a maximum difference 

that was close to a multiple of two. This means that at the parameters run, shear stress varies 

significantly in the NCB dish.  

One direct observation about dimensionless shear is that visual inspection of the shear 

contours showed that the dimensionless shear, in the main fluid wave, regularly exceeded a value of 

1.0. The contours max out near a value of 4.0, but the average values in Figure 42 are less than 1.0. 

Because there is more area of lower shear, it brings the average down.. There is a small region near 

the wall that deviates from Equation 6. Near the wall is where one would expect the greatest 

deviation.  In fact, visually, the dimensionless shear fell close to a value of 1.8 for most of the fluid 

wave in all cases and reached a maximum value of 4 in the 60 RPM, 90 RPM, 120 RPM and 150 
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RPM cases. Thus, the viscous shear equation over predicts the magnitude of shear stress. The reason 

Equation 6 over predicts is most likely due to the centrifugal forces that act on a banked surface 

instead of parallel to the bottom surface. The additional force would theoretically increase the shear 

stress on the bottom surface. Based on the results of the average dimensionless shear values being 

less than one and shear contours fluid wave values being greater than one, it is logical to conclude 

that the viscous favored shear equation is not an adequate equation for calculating shear stress in the 

NCB dish at these conditions. 
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FIGURE 36 – Narrow Channel Banked Dish Dimensionless Shear Stress Contour 60 RPM (Stokes: 

0.03, Slope: 0.96, Froude: 0.13, and Reynolds: 0.003) 

 

FIGURE 37 – Narrow Channel Banked Dish Dimensionless Shear Stress Contour 90 RPM (Stokes: 

0.12, Slope: 0.91, Froude: 0.19, and Reynolds: 0.04) 
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FIGURE 38 – Narrow Channel Banked Dish Dimensionless Shear Stress Contour 120 RPM (Stokes: 

0.3, Slope: 0.85, Froude: 0.26, and Reynolds: 0.29) 

 

FIGURE 39 – Narrow Channel Banked Dish Dimensionless Shear Stress Contour 150 RPM (Stokes: 

0.41, Slope: 0.76, Froude: 0.32, and Reynolds: 0.53) 
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FIGURE 40 – Narrow Channel Banked Dish Dimensionless Shear Stress Contour 180 RPM (Stokes: 

0.52, Slope: 0.66, Froude: 0.39, and Reynolds: 0.86) 

 

     

FIGURE 41  - Narrow Channel Banked Dish Phase Contour 120 RPM (Left), 60 RPM (Middle), and 

180 RPM (Right) 

 

2nd Region 
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FIGURE 42– Narrow Channel Banked Dish Dimensionless Shear Stress Vs RPM 

G. NCB Tangential vs Radial Plots 

The tangential vs radial plots for the NCB dishes show uniaxial tangential favored shear stress. 

This is displayed in the example plots in Figures 43 and 44. Additionally, because this trend is 

persistent in all NCB cases, APPENDIX B Figures 76 – 85 also show this trend. This characteristic 

of the narrow channel banked dishes is a benefit because it produces more uniaxial flow as opposed 

to flow patterns for the conventional dish which is more bidirectional and difficult to characterize.    
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FIGURE 43 - Narrow Channel Banked Dish 150 RPM At 10%, 20, and 40% 

 

FIGURE 44 - Narrow Channel Banked Dish 150 RPM At 60%, 80%, and 90% 
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H. NCB Trend Line Slopes 

The slope values for the NCB dish are shown for the 150 RPM case in Figures 45. (All the slope 

data for each case can be found in APPENDIX B in Table II.) The values are identified at only the 

40%, 80% and 90% locations.  For the NCB dish they increased from 3.445 to 5.663 to 6.974.  This 

indicated a progression towards tangential flow with increasing radii. Scatter plots, displaying slope 

values against radial location, for the NCB geometry are displayed in Figures 46 (60 and 90 rpm) and 

47 (120-180 rpm). The slopes remain relatively flat at 60 and 90 rpm (above the 10% radius). Yet, at 

orbital speeds greater than 90 RPM, the slope values visually began to increase as radii increased.  

 

 

FIGURE 45- Narrow Channel Banked Dish 150 RPM At 40%, 80%, and 90% 
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FIGURE 46- NCB Dish Slope Values VS Radial Location At 60 And 90 RPM 

 

FIGURE 47- NCB Dish Slope Values VS Radial Location at 120, 150 and 180 RPM 

I. NCB DOSI Vs Location 

The ranges for NCB’s DOSI values averaged to be 0.01 at 10% and 0.99 at 90% (both of 

which correspond respectively to the minimum and maximum DOSI values). Within these ranges the 

NCB dish created three distinct regions of DOSI (Figure 48). Region one consisted of the 10% to 

20% locations, region two was from 40% to 60%, and region three was from 80% to 90%. DOSI 
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values in the first region remained near zero. DOSI values in the second region constituted a sharp 

transition between region one and three. DOSI in the third region remained near one.  

 

FIGURE 48 – Narrow Channel Banked Dish DOSI vs Location Graph 

J. Conventional Dish Shear Stress Contours 

 Several observations can be made surrounding the differences in the shear stress contours as 

orbital speed increases. For example, the maximum shear stress increased on the order of 35 times 

from the lowest orbital speed to the highest.  The maximum shear stress magnitude was around 0.6 

dynes/cm2 at 60 RPM and 22 dynes/cm2 at 180 RPM. (These magnitudes can be seen on the contours 

in APPENDIX B Figures 106 – 110 that display actual shear.) At the lowest orbital speed (60 RPM) 

the shear stress contour appeared as shown in Figure 106. As the orbital speed increased (90 RPM, 

120 RPM, 150 RPM, and 180 RPM) the concentrated region moved toward the outer wall and 

resembled a crescent. Figure 54 shows that drying is present and the amount of dry area increases 

from 60 RPM to 180 RPM in the conventional dish. Drying has been present in past experiments 

when using the conventional dish (Thomas (2007).  

0

0.2

0.4

0.6

0.8

1

1.2

0 20 40 60 80 100

D
O

SI
 

Gap Percentage (%) 

60 rpm

90 rpm

120 rpm

150 rpm

180 rpm



61 

 

 To examine how dimensionless shear changed based on radial location a plot was prepared 

as seen in Figure 55. The plot shows the average magnitude of dimensionless shear experienced at 

each location and orbital speed. One obvious observation gathered from Figure 55 is that the 

dimensionless shear averages did not equal one. This means that a viscous favored shear prediction is 

not accurate for estimating shear in the conventional dish, as was the case for the two narrow channel 

dishes. For the conventional dish the average dimensionless shear values only ranged from 0.067 to 

0.196. Even a visual inspection of the contours shows that the dimensionless shear, in the main fluid 

wave, does not approach one.  The values in the contours never exceed 0.5. Thus the viscous favor 

shear prediction equation under predicts the magnitude of shear stress in the conventional dish. The 

reason it under predicts is most likely due to the wall affects and high dimensionless variables. The 

equation is only valid with no walls effects and low dimensionless variables.  

The variation in shear stress throughout different locations on a conventional dish has been 

problematic in terms of quantifying cellular responses in such systems. Quantifying the variation is 

necessary for characterizing fluid flow. Figure 55 shows at 120 RPM the maximum variation in 

dimensionless shear occurs between the 90% location and 10% location with an average value of 

0.196 and 0.083, respectively. This means the average dimensionless shear stress differs by 

approximately a multiple of two between these two locations at that orbital speed. The maximum 

differences between two radial locations (meaning the difference between the maximum and 

minimum values at an orbital speed) are 0.024 for 60 RPM, 0.068 for 90 RPM, 0.113 for 120 RPM, 

0.104 for 150 RPM and 0.083 for 180 RPM. However, relative to the other orbital speeds, there is 

significant less variation in the 60 RPM case.  
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FIGURE 49 – Conventional Dish Dimensionless Shear Stress Contour 60 RPM Large Scale (Left) 

And Small Scale (Right) (Stokes: 0.14, Slope: 0.33, Froude: 0.78, and Reynolds: 0.18) 

 

 

FIGURE 50 – Conventional Dish Dimensionless Shear Stress Contour 90 RPM (Stokes: 0.56, Slope: 

0.75, Froude: 1.18, and Reynolds: 2.75) 
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FIGURE 51 – Conventional Dish Dimensionless Shear Stress Contour 120 RPM (Stokes: 1.45, 

Slope: 1.34, Froude: 1.57, and Reynolds: 18.36) 

 

FIGURE 52 – Conventional Dish Dimensionless Shear Stress Contour 150 RPM (Stokes: 1.98, 

Slope: 2.09, Froude: 1.96, and Reynolds: 34.42) 
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FIGURE 53 – Conventional Dish Dimensionless Shear Stress Contour 180 RPM (Stokes: 2.51, 

Slope: 3.01, Froude: 2.35, and Reynolds: 55.07) 

 

      

FIGURE 54 - Conventional Dish Phase Contour 60 RPM (Left), 120 RPM (Middle), and 180 RPM 

(Right) 
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FIGURE 55– Conventional Dish Dimensionless Shear Stress Vs RPM 

K. Conventional Dish Tangential vs Radial Plots 

The conventional dish cases (Figure 56 - 59) show a circular shape at lower radial locations, 

and then elongate towards the tangential direction at larger radii. This highlights the basic trend 

observed previously (Charkraborty et al (2011)). As radial location increased, uniaxial tangential 

flow increased. For the lower orbital speeds (60 RPM and 90 RPM) the shift occurred at higher radii 

locations (80% to 100%), seen in Figures 56 - 57.  At higher orbital speeds (120 RPM, 150 RPM, and 

180 RPM) the shift occurred at 10% radii, which can be seen in the Figures 58 – 59. (Addition plots 

for the conventional dish are displayed in APPENDIX B Figures 86 - 95.  
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FIGURE 56 – Narrow Channel Conventional Dish 60 RPM 10% TO 40%

 

FIGURE 57 – Narrow Channel Conventional Dish 60 RPM 60% TO 90% 
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FIGURE 58 – Conventional Dish 180 RPM At 10%, 20, and 40% 

 

FIGURE 59 – Conventional Dish 180 RPM At 60%, 80%, And 90% 
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L. Conventional Dish Trend Line Slopes 

The slope values for the conventional dish are shown in Figure 60 using 150 RPM as an 

example case. (All the slope data for each case can be found in APPENDIX B in Table II.) The 

values are identified at only 40%, 80% and 90% and for the conventional dish the slope values 

increased from 0.484 to 1.385 to 2.389. The slopes gradually became more vertical as radial location 

increased, which indicated a progression towards tangential flow with increasing radii. This confirms 

the conclusions from the previous section. The slope trends for all the conventional dish cases are 

displayed in Figure 61 as a scatter plot. As seen in Figure 61, it is evident that the slope magnitude 

increased as radial location increased consistently in all conventional dish cases. An interesting 

observation is that the slope in conventional dishes increased exponentially. This suggests a strong 

relationship between slope value and orbital speed at the tested parameters.   
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FIGURE 60– Conventional Dish 180 RPM At 40%, 80% and 90% 

 

FIGURE 61- Conventional Dish Slope Values VS Radial Location 
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M. Conventional DOSI Vs Location 

The ranges for conventional dish DOSI values averaged to be 0.09 at 10% and 0.74 at 90% 

(both of which correspond respectively to the minimum and maximum DOSI values). The bi-

directionality in conventional dishes created DOSI numbers that are low near the center, which in 

Figure 62 correspond to the 0% location. Then as the radius and speed increased, shear became more 

unidirectional, causing DOSI to approach one. This shift is the primary reason conventional dishes 

are impractical for experimental analysis of cellular responses. 

 

FIGURE 62 – Conventional Dish DOSI vs Location Graph 
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V. CONCLUSION 

There are conclusions or observations that are specific to a particular geometry, all 

geometries, or solely the narrow channel dishes. These conclusions are only valid within the 

dimensionless variable ranges found in Table I.  

First, the conclusions that pertain to all geometries are: All the geometries have shear stress 

values generally between 0 and 25 dynes. The different geometries’ shear stress values consistently 

increase as orbital speed increases. The maximum shear stress values occur closer to the leading edge 

of the waves. However, the maximum shear stress occur in different regions for each geometry.  The 

NCF reaches a maximum magnitude at ~60% of the radius, NCB at ~80%, and the conventional dish 

at ~90%. For the dimensionless shear plots NCF reaches a maximum at 120 RPM, NCB at 90 RPM, 

and conventional dish 120 RPM. There is a general trend that as radial location increases tangential 

motion becomes stronger in all geometries.  Lastly, Equation 6 inaccurately predicts shear in each 

geometry. In the NCF dish Equation 6 under predicts, in the NCB dish it over predicts, and in the 

conventional dish it under predicts shear stress.  

In the NCF and NCB dishes elongation towards tangential motion starts immediately at the 10% 

location as opposed to the conventional case that starts more circular at 10% and then became 

elongated as radial location increased.  

In the NCF dish, for a given orbital speed, the slope values are at a minimum at the center and 

increase towards either wall. There is significant variation in dimensionless shear stress on the 

bottom surface between radial locations. For example, at 120 RPM the average dimensionless shear 

stress can vary by a multiple of three. DOSI values show lower variability as orbital speed increased. 

The ranges for NCF’s DOSI values average to be .21 at 10% and .54 at 60%.  
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Drying occurs at all orbital speeds in the NCB but more drying occurred as speed increased. 

There is significant variation in dimensionless shear stress on the bottom surface between radial 

locations. For example, at 60 RPM the average dimensionless shear stress can vary by a multiple of 

three. The (tangential vs radial) slope was steady at lower orbital speeds and increased linearly at 

higher orbital speeds for the NCB dish. The DOSI values average to be .01 at 10% and .96 at 90%,    

thus increase with increasing radii. Lastly, the DOSI values had a sharp transition. Meaning, DOSI in 

a region from 10% to 20% remained near zero and DOSI in the other region from 80% to 90% 

remained near one. The quick transition occurred near the 50% gap length location. 

In the conventional dish, drying occurs at all orbital speeds but more drying occurs as speed 

increased. The conventional dish’s tangential vs radial plots had a circular shape at lower radial 

locations at all orbital speeds.  As speed increased the shape became more elliptical by elongating in 

the tangential (vertical direction).  The circular shape represents the bidirectional shear behavior near 

the center of dishes.  However, as the radial location increase, uniaxial tangential behavior was 

favored. The (tangential vs radial graph) slope increase exponentially with orbital speed for the 

conventional cases. Finally, the DOSI values average to be .06 at 10% and .72 at 90% and increase 

with increasing radial location. 

In summary there were several key findings pertaining to the stated objectives that resulted 

from this work. For the NCF dish the least variation in shear magnitude, between radial locations, 

occurs at 60 RPM. In terms of the DOSI values, the NCF dish had increasingly higher DOSI values, 

meaning more uniaxial favored (tangential) flow across the surface of the dish as speed increased. 

The lowest variation occurred at 180 RPM. For the NCB dish the least variation in shear magnitude, 

between radial locations, occurred at 90 RPM. The NCB dish’s narrow range of shear stress is 

hypothesized to be the result of a more parallel fluid surface relative to the bottom surface of the 
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dish. The NCB dish had DOSI values close to 1.0, meaning more uniaxial favored (tangential) flow, 

at the 80% and 90% radial locations for speeds between 120 and 180 rpm. 
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VI. RECOMMENDATIONS 

 

Future studies should analyze the novel geometries by varying the dimensionless parameters 

individually. Studies should examine different fluid heights since height is a key factor in shear stress 

magnitude.  Other geometries should be studied such as a banked dish with different angles, or non-

narrow channel banked bottom dishes.  While shear stress in conventional dishes has been 

experimentally validated with PIV (Particle Image Velocimetry), new geometries may require their 

own experimental and/or analytical validation. 
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APPENDIX A 

COMPUTER AND FLUENT PROGRAMS  

 

#include "udf.h"  

DEFINE_CG_MOTION(rotor_motion, dt, cg_vel, cg_omega, time, dtime)  

{  

real w,angle;  

real offset = 0.;  

real radius = 0.012;  

w = 28.5774;  

NV_S (cg_omega, =, 0.0);  

NV_S (cg_vel, =, 0.0);  

angle = w*time + offset;  

cg_vel[0] = -radius * w * sin(angle);  

cg_vel[1] = radius * w * cos(angle);  

} 

FIGURE 63 – Example User Defined Function 

 

 

#!/bin/bash  

#PBS -q dualcore2  

#PBS -l nodes=1:ppn=1  

#PBS -m e  

#PBS -M jmthom27@louisville.edu  

INPUT_FILE=/scr/JMDT/thesis/stokes/stokes10/inputfile_uss  

OUTPUT_FILE=/scr/JMDT/thesis/stokes/stokes10/outputfile  

DIM=3d  

PROG="/apps/Fluent.Inc/bin/fluent "  

PROGARGS="$DIM -g -i $INPUT_FILE"  

echo Running on:  

cat $PBS_NODEFILE  

NPROCS=`wc -l < $PBS_NODEFILE`  

echo This job uses $NPROCS processors  

hostname  

$PROG $PROGARGS > $OUTPUT_FILE 2>&1 

FIGURE 64 – Example Batch File 
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rc /scr/JMDT/thesis/stokes/stokes10/10stokes5.cas  

rd /scr/JMDT/thesis/stokes/stokes10/10stokes5.dat  

solve  

d  

859  

50  

wc /scr/JMDT/thesis/stokes/stokes10/10stokes0864.cas  

wd /scr/JMDT/thesis/stokes/stokes10/10stokes0864.dat  

quit  

exit  

yes 

FIGURE 65 – Example Input File 
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FIGURE 66 – Narrow Channel Flat Dish 60 RPM 10% TO 40%

 

FIGURE 67 – Narrow Channel Flat Dish 60 RPM 60% TO 90% 
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FIGURE 68 – Narrow Channel Flat Dish 90 RPM 10% TO 40% 

 

FIGURE 69 – Narrow Channel Flat Dish 90 RPM 60% TO 90% 
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FIGURE 70 – Narrow Channel Flat Dish 120 RPM 10% TO 40%

 

FIGURE 71 – Narrow Channel Flat Dish 120 RPM 60% TO 90% 
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FIGURE 72 – Narrow Channel Flat Dish 150 RPM 10% TO 40% 

 

FIGURE 73 – Narrow Channel Flat Dish 150 RPM 60% TO 90% 
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FIGURE 74 – Narrow Channel Flat Dish 180 RPM 10% TO 40% 

 

FIGURE 75 – Narrow Channel Flat Dish 180 RPM 60% TO 90% 
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FIGURE 76 – Narrow Channel Banked Dish 60 RPM 10% TO 40% 

 

FIGURE 77 – Narrow Channel Banked Dish 60 RPM 60% TO 90% 

-3

-2.5

-2

-1.5

-1

-0.5

0

0.5

1

1.5

2

-2 -1.5 -1 -0.5 0 0.5 1 1.5 2

Ta
n

ge
n

ti
al

 W
SS

 (
d

yn
e

/c
m

2
) 

Radial WSS (dyne/cm2) 

10%

20%

40%

-3

-2.5

-2

-1.5

-1

-0.5

0

0.5

1

1.5

-3 -2 -1 0 1 2 3

Ta
n

ge
n

ti
al

 W
SS

 (
d

yn
e

/c
m

2
) 

Radial WSS (dyne/cm2) 

60%

80%

90%



88 

 

 

FIGURE 78 – Narrow Channel Banked Dish 90 RPM 10% TO 40%

 

FIGURE 79 – Narrow Channel Banked Dish 90 RPM 60% TO 90% 
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FIGURE 80 – Narrow Channel Banked Dish 120 RPM 10% TO 40% 

 

FIGURE 81 – Narrow Channel Banked Dish 120 RPM 60% TO 90% 
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FIGURE 82 – Narrow Channel Banked Dish 150 RPM 10% TO 40% 

 

FIGURE 83 – Narrow Channel Banked Dish 150 RPM 60% TO 90% 
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FIGURE 84 – Narrow Channel Banked Dish 180 RPM 10% TO 40% 

 

FIGURE 85 – Narrow Channel Banked Dish 180 RPM 60% TO 90% 
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FIGURE 86 – Narrow Channel Conventional Dish 60 RPM 10% TO 40%

 

FIGURE 87 – Narrow Channel Conventional Dish 60 RPM 60% TO 90% 
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FIGURE 88 – Narrow Channel Conventional Dish 90 RPM 10% TO 40% 

 

FIGURE 89 – Narrow Channel Conventional Dish 90 RPM 60% TO 90% 
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FIGURE 90 – Narrow Channel Conventional Dish 120 RPM 10% TO 40% 

 

FIGURE 91 – Narrow Channel Conventional Dish 120 RPM 60% TO 90% 
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FIGURE 92 – Narrow Channel Conventional Dish 150 RPM 10% TO 40% 

 

FIGURE 93 – Narrow Channel Conventional Dish 150 RPM 60% TO 90% 
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FIGURE 94 – Narrow Channel Conventional Dish 180 RPM 10% TO 40% 

 

FIGURE 95 – Narrow Channel Conventional Dish 180 RPM 60% TO 90% 
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FIGURE 96 – Narrow Channel Flat Dish Shear Stress Contour 60 RPM 

 

 

 

FIGURE 97 – Narrow Channel Flat Dish Shear Stress Contour 90 RPM 
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FIGURE 98 – Narrow Channel Flat Dish Shear Stress Contour 120 RPM 

 

 

 

FIGURE 99 – Narrow Channel Flat Dish Shear Stress Contour 150 RPM 
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FIGURE 100 – Narrow Channel Flat Dish Shear Stress Contour 180 RPM 

 

 

 

FIGURE 101 – Narrow Channel Banked Dish Shear Stress Contour 60 RPM 
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FIGURE 102 – Narrow Channel Banked Dish Shear Stress Contour 90 RPM 

 

 

FIGURE 103 – Narrow Channel Banked Dish Shear Stress Contour 120 RPM 
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FIGURE 104 – Narrow Channel Banked Dish Shear Stress Contour 150 RPM 

 

 

 

FIGURE 105 – Narrow Channel Banked Dish Shear Stress Contour 180 RPM 
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FIGURE 106 – Conventional Dish Shear Stress Contour 60 RPM 

 

 

 

FIGURE 107 – Conventional Dish Shear Stress Contour 90 RPM 
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FIGURE 108 – Conventional Dish Shear Stress Contour 120 RPM 

 

 

FIGURE 109 – Conventional Dish Shear Stress Contour 150 RPM 



104 

 

 

 

FIGURE 110 – Conventional Dish Shear Stress Contour 180 RPM 
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TABLE II – Slopes Corresponding With Primary Axis Relation To Tangential/Radial Direction 

Case RPM 
Gap 

% Slope Case RPM 
Gap 

% Slope Case RPM 
Radius 

% Slope 
Flat 60 10 9.81 Banked 60 10 1.18 Conventional 60 10 -0.08 

Flat 60 20 0.03 Banked 60 20 -5.21 Conventional 60 20 -0.06 

Flat 60 40 -0.84 Banked 60 40 -3.77 Conventional 60 40 -0.11 

Flat 60 60 -0.88 Banked 60 60 -3.06 Conventional 60 60 -0.21 

Flat 60 80 1.89 Banked 60 80 -4.87 Conventional 60 80 -0.18 

Flat 60 90 16.10 Banked 60 90 -4.17 Conventional 60 90 -0.77 

Flat 90 10 -3.41 Banked 90 10 -0.64 Conventional 90 10 0.07 

Flat 90 20 -2.67 Banked 90 20 -5.48 Conventional 90 20 0.13 

Flat 90 40 -2.59 Banked 90 40 -3.67 Conventional 90 40 0.24 

Flat 90 60 -3.50 Banked 90 60 -4.11 Conventional 90 60 0.09 

Flat 90 80 -5.61 Banked 90 80 -4.67 Conventional 90 80 -1.01 

Flat 90 90 -4.90 Banked 90 90 -3.97 Conventional 90 90 -1.84 

Flat 120 10 -8.25 Banked 120 10 -1.67 Conventional 120 10 0.17 

Flat 120 20 -3.76 Banked 120 20 -4.88 Conventional 120 20 0.04 

Flat 120 40 -3.28 Banked 120 40 -3.45 Conventional 120 40 -0.19 

Flat 120 60 -3.81 Banked 120 60 -4.05 Conventional 120 60 -0.61 

Flat 120 80 -6.05 Banked 120 80 -5.66 Conventional 120 80 -1.14 

Flat 120 90 -11.64 Banked 120 90 -6.97 Conventional 120 90 -2.20 

Flat 150 10 -12.95 Banked 150 10 -2.33 Conventional 150 10 -0.15 

Flat 150 20 -5.22 Banked 150 20 -3.73 Conventional 150 20 -0.23 

Flat 150 40 -3.90 Banked 150 40 -3.21 Conventional 150 40 -0.48 

Flat 150 60 -4.26 Banked 150 60 -4.14 Conventional 150 60 -0.88 

Flat 150 80 -6.72 Banked 150 80 -5.79 Conventional 150 80 -1.39 

Flat 150 90 -14.31 Banked 150 90 -5.88 Conventional 150 90 -2.39 

Flat 180 10 -7.15 Banked 180 10 -2.62 Conventional 180 10 -0.09 

Flat 180 20 -4.35 Banked 180 20 -3.44 Conventional 180 20 -0.16 

Flat 180 40 -4.03 Banked 180 40 -3.34 Conventional 180 40 -0.52 

Flat 180 60 -5.08 Banked 180 60 -4.10 Conventional 180 60 -1.00 

Flat 180 80 -7.64 Banked 180 80 -5.86 Conventional 180 80 -1.60 

Flat 180 90 -14.99 Banked 180 90 -8.89 Conventional 180 90 -2.70 
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TABLE III – Narrow-Channel Dish Size and Time For Steady State Runs Chart Part 1 

CASE 
Height 
(mm) 

Diameter 
(bottom-

mm) Angle 
Thickness 

(mm) 
Cells 

Height 

Number 
of Cells 
(Height) 

Cell 
Gap 

Number 
of Cells 
(Gap) 

1 10 35 90 2.5         

2 20 35 90 2.5 0.0005 40 5 54400 

3 20 35 90 2.5 0.0005 40 10 205920 

4 20 35 90 2.5 0.0005 40 15 475480 

5 20 35 90 2.5 0.001 20 5 27200 

6 20 35 90 2.5 0.001 20 10 102960 

7 20 35 90 2.5 0.0005 40 5 54400 

8 20 35 90 2.5 0.0005 40 15 475480 

9 20 35 90 2.5 0.001 20 10 102960 

10 10 35 90 2.5 0.0002 50 5 168600 

11 10 35 90 2.5 0.0002 50 10 307850 

12 10 35 90 2.5 0.0002 50 15 504050 

13 10 35 90 2.5 0.0003 33.33333 5 73712 

14 10 35 90 2.5 0.0003 33.33333 10 172346 

15 10 35 90 2.5 0.0003 33.33333 15 336804 

16 10 35 90 2.5 0.00015 66.66667 5 308066 

17 10 35 90 2.5 0.00015 66.66667 7 393223 

18 10 35 90 2.5 0.00015 66.66667 9 468263 

19 10 35 90 2.5 0.0003 33.33333 16 466072 

20 10 35 90 2.5 0.0004 25 15 245500 

21 10 35 90 2.5 0.0004 25 19 486425 

22 10 35 90 2.5 0.0005 20 15 194220 

23 10 35 90 2.5 0.0005 20 20 432000 

24 10 35 90 2.5 0.0006 16.66667 5 22797 

25 10 35 90 2.5 0.0006 16.66667 10 83912 

26 10 35 90 2.5 0.00075 13.33333 10 69188 

27 10 35 90 2.5 0.0008 12.5 10 64246 

28 10 35 90 2.5 0.001 10 5 13380 

29 10 35 90 2.5 0.001 10 10 49420 

30 10 35 90 2.5 0.0002 50 5 168600 

31 10 35 90 2.5 0.0003 33.33333 5 73712 

32 10 35 90 2.5 0.0003 33.33333 10 172346 

33 10 35 90 2.5 0.0004 25 15 245500 
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TABLE IV – Narrow-Channel Dish Size and Time For Steady State Runs Chart Part 2 

CASE 

Bottom 
Cell 

Count RPM 

Run 
Time 
(Time 
Steps) Seconds Rotations 

Max Bottom 
Shear 

(dyne/cm2) 

Average 
Bottom Shear 

Stress 
(dyne/cm2) 

1   120 2000 2 4 2.244463 1.017279 

2   120 2000 2 4 12.08155 3.097948 

3   120 2000 2 4 18.3149 2.757896 

4   120 1750 1.75 3.5 20.50029 2.607605 

5   120 2000 2 4 11.30507 2.088004 

6   120 2000 2 4 15.61587 1.828051 

7 1360 60 2000 2 2 1.852341 0.7793514 

8 11887 60 2000 2 2 2.006745 0.8404718 

9 5148 60 2000 2 2 1.488952 0.6220465 

10 3372 60 4000 4 4 2.14532 0.8758979 

11 6157 60 4000 4 4 2.121403 0.8718316 

12 10081 60 1250 1.25 1.25 4.007246 0.8327431 

13 2211 60 4000 4 4 2.053297 0.8296435 

14 5170 60 4000 4 4 2.124162 0.8856301 

15 10104 60 3000 3 3 2.13615 0.8915288 

16 4621 60 4000 4 4 2.009532 0.839452 

17 5898 60 3000 3 3 2.180534 0.8675869 

18 7024 60 2250 2.25 2.25 2.375 0.8769029 

19 13982 60 2000 2 2 2.516409 0.8923212 

20 9820 60 4000 4 4 2.121051 0.8874801 

21 19457 60 1250 1.25 1.25 2.033 0.7513183 

22 9711 60   0 0 0 0 

23 21600 60   0 0 0 0 

24 1368 60 4000 4 4 1.482066 0.5464445 

25 5035 60   4 4 1.58148 0.6016173 

26 5189 60 4000 4 4 1.649635 0.6557856 

27 5140 60   4 4 1.515858 0.547574 

28 1338 60   4 4 1.387642 0.6231371 

29 4942 60   4 4 1.484057 0.6317395 

30 3372 60 4000 4 4 2.14532 0.8758979 

31 2211 60 4000 4 4 2.053297 0.8296435 

32 5170 60 4000 4 4 2.124162 0.8856301 

33 9820 60 4000 4 4 2.121051 0.8874801 
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TABLE V – 73712 Cell Narrow Channel Dish Time Step Run 

Time 
Step Seconds Rotations Max Shear 

Average 
Shear 

100 0.1 0.1 1.059997 0.5353 

200 0.2 0.2 0.5588 0.214557 

300 0.3 0.3 0.9296 0.4779 

400 0.4 0.4 1.817873 0.92604 

1000 1 1 2.0843 0.9059 

2000 2 2 2.02846 0.82999 

3000 3 3 2.026519 0.8321 

4000 4 4 2.053297 0.829644 

 

TABLE VI – 168600 Cell Narrow Channel Dish Time Step Run 

Time 
Step Seconds Rotations 

Max 
Shear 

Average 
Shear 

100 0.1 0.1 1.032 0.54192 

200 0.2 0.2 2.011026 0.638722 

300 0.3 0.3 0.9647 0.499568 

400 0.4 0.4 1.785 0.936 

500 0.5 0.5 1.818 0.821 

1000 1 1 2.101 0.942 

1500 1.5 1.5 2.133 0.923 

2000 2 2 2.092 0.878 

2500 2.5 2.5 2.135 0.91 

3000 3 3 2.077 0.872 

3500 3.5 3.5 2.141 0.907 

4000 4 4 2.145 0.876 
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TABLE VII – 172300 Cell Narrow Channel Dish Time Step Run 

Time 
Step Seconds Rotations 

Max 
Shear 

Average 
Shear 

100 0.1 0.1 1.116765 0.53757 

200 0.2 0.2 0.5077 0.22253 

300 0.3 0.3 1.064679 0.478656 

400 0.4 0.4 1.902843 0.92941 

500 0.5 0.5 1.766 0.835 

1000 1 1 2.133 0.949 

2000 2 2 2.106 0.883 

3000 3 3 2.106 0.887 

4000 4 4 2.124 0.886 

 

 

TABLE VIII – 245500 Cell Narrow Channel Dish Time Step Run 

Time 
Step Seconds Rotations Max Shear 

Average 
Shear 

100 0.1 0.1 1.1206 0.51933 

200 0.2 0.2 0.54198 0.24132 

300 0.3 0.3 1.0939 0.42151 

1000 1 1 2.1394 0.950416 

2000 2 2 2.11015 0.88671 

3000 3 3 2.10644 0.884751 

4000 4 4 2.12105 0.88748 
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TABLE IX – Dimensionless Parameter Variables 

Dish RPM R a 𝜔  g H p 𝑣 u 

NCF 

60 0.0095 0.0025 6.2832 9.81 .000769 997.3 1.194195 .0157 

90 0.0095 0.0025 9.4248 9.81 .000769 997.3 0.119478 .0235 

120 0.0095 0.0025 12.5664 9.81 .000769 997.3 0.023896 .0314 

150 0.0095 0.0025 15.7080 9.81 .000769 997.3 0.015931 .0392 

180 0.0095 0.0025 18.8496 9.81 .000769 997.3 0.011948 .0471 

NCB 

60 0.0095 0.0025 6.2832 9.81 .000414 997.3 1.194195 .0157 

90 0.0095 0.0025 9.4248 9.81 .000414 997.3 0.119478 .0235 

120 0.0095 0.0025 12.5664 9.81 .000414 997.3 0.023896 .0314 

150 0.0095 0.0025 15.7080 9.81 .000414 997.3 0.015931 .0392 

180 0.0095 0.0025 18.8496 9.81 .000414 997.3 0.011948 .0471 

Conventional 

60 0.0095 0.0175 6.2832 9.81 0.002 997.3 1.194195 .1099 

90 0.0095 0.0175 9.4248 9.81 0.002 997.3 0.119478 .1649 

120 0.0095 0.0175 12.5664 9.81 0.002 997.3 0.023896 .2199 

150 0.0095 0.0175 15.7080 9.81 0.002 997.3 0.015931 .2748 

180 0.0095 0.0175 18.8496 9.81 0.002 997.3 0.011948 .3298 

 

TABLE X – Average Dimensionless Shear Stress Experienced In Each Radial Location 

  
Radial Location 

Dish RPM 10% 20% 40% 60% 80% 90% 

NCF 

60 0.220 0.323 0.393 0.388 0.308 0.206 

90 0.172 0.253 0.366 0.448 0.353 0.220 

120 0.163 0.265 0.414 0.485 0.403 0.257 

150 0.166 0.282 0.419 0.461 0.385 0.249 

180 0.186 0.290 0.393 0.424 0.357 0.236 

NCB 

60 0.308 0.536 0.711 0.697 0.412 0.246 

90 0.279 0.474 0.641 0.693 0.654 0.473 

120 0.253 0.414 0.584 0.636 0.644 0.495 

150 0.231 0.380 0.592 0.626 0.664 0.580 

180 0.225 0.382 0.603 0.587 0.624 0.546 

Conventional 

60 0.067 0.065 0.063 0.058 0.049 0.043 

90 0.117 0.115 0.109 0.100 0.135 0.168 

120 0.083 0.098 0.114 0.141 0.175 0.196 

150 0.091 0.088 0.095 0.133 0.179 0.191 

180 0.102 0.099 0.079 0.111 0.156 0.162 
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